
1NMAC Website - www.nmac.org

 Started as a collaborative effort with Apple computers in 1990.

 Distributes 100 computers to faith- and community-based 
organizations throughout the U.S. and its territories based on need 

and geographic diversity.

 Today, it is funded by Office of AIDS Research (OAR), a branch of 
the National institutes of Health (NIH).

 This is the second year of the Equal Access Initiative: HIV/AIDS 
Information Resources from the National Library of Medicine Training.

 The 2009 RFP is available! 

Equal Access Initiative 
(EAI):

Computer Grants Program

Presenter
Presentation Notes
Instructor Notes:

Note about Dell: 

We would be remiss if we did not mention this year’s vendor, Dell. Many of you received your equipment on time; without any problems. �
If you are among the small number of organizations that had difficulty obtaining your computer grant equipment, we apologize. 

We will not be using Dell again next year. 
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 The EAI is facilitated by the National Minority AIDS Council (NMAC), located in 
Washington, DC’s historic U Street Corridor. 

 The agency formed in incorporated in 1987 to raise awareness around the impact of 
HIV/AIDS in communities of color.

 In 1989, the mission of the agency changed to “building leadership within 
communities of color to address the challenges of HIV/AIDS.” 

 The agency honored its 20th year of service in 2007.

Who Is NMAC?

NMAC -
1990

NMAC Founders meeting with 
Surgeon General C. Everett Koop, 

fall 1986

NMAC -
1995

Presenter
Presentation Notes
Instructor Notes:

Mission: That is, NMAC helps leverage the community-based response to HIV/AIDS, enabling its constituents –  faith- and community-based organizations like yours – to deliver services more quickly and efficiently. �

20th anniversary: 

On 7 November – come to the special event tonight

On 8 November – remind them to see the columns in the exhibit hall.
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 Within NMAC, the EAI program is facilitated by the Communications 
Division. We also support NMAC programs, activities and events by 

providing and/or maintaining:

 Media / Press

 Electronic Communications

 Website

 IT/Equipment/Database Services

 Publications – Fulfillment 

 Ancillary Programs / Initiatives 

Who Oversees the EAI 
Within NMAC?

L-to-R: Abdul Majid 
Khan, Matthew Mann, 

Yadira Feliciano-Lacot, 
Circe J. Gray Le CompteCONTACT US! 

NMAC – Communications
1624 U Street, NW, Ste. 200
Washington, DC 20009-4432

Telephone: (202) 234-5120 ext. 309
Mobile: (202) 352-7240

www.nmac.org * communications@nmac.org

Presenter
Presentation Notes
Instructor Notes:

 Check out our new e-newsletter 
 Website coming soon 
 New exhibit booth��
Other ways we can help you – 
* Ideas about website design / content management system development
* Printing and design vendor recommendations
* Database selection and migration recommendations

That is the Communications Neko – The cat is not waving; but beckoning you to come closer and look.

The Communications Division oversees all media activities for the National Minority AIDS Council, including the promotion of its signature event, the United States Conference on AIDS (USCA); the management of all news outlet inquiries; and the distribution of press releases and other media. ��The Division also handles the agency’s internal information technology (IT) services and website, www.nmac.org. Communications also works in partnership with internal offices and outside vendors to produce all of NMAC’s publications – including booklets, flyers, postcards, posters and other media – at the best possible price and in accordance with set branding and standard operation procedures. 


http://www.nmac.org/�
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Other NMAC programs and services that might be of interest to your organization:  



 2009 USCA – San Francisco, CA, October 29-31  
www.2009USCA.org



Presenter
Presentation Notes
Instructor Notes:

HPLS is primarily for CDC funded F/CBOs. ��NMAC facilitates this conference on behalf of the CDC. Until 2005, this meeting was called the Community Prevention Leadership Summit (CPLS) and the HIV Prevention Community Co-�Chairs Meeting.�


http://www.2009usca.org/�
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Other NMAC programs and services that might be of interest to your organization:  

 Technical Assistance, Training and Treatment Division

 Individualized Capacity Building Assistance (ICBA)

 Supporting Networks of HIV Care (SNHC)

 HIV/AIDS Stigma Program

 Prison Initiative Program 

Presenter
Presentation Notes
Instructor Notes:

ICBA – this is for directly and indirectly CDC-funded organizations. (Sometimes your health department has to request these services for you.) 

For more information about all of our services, please visit us at booth #48 – where you also can have your picture taken with NMAC staff and/or your friends and pick them up the next day – no charge! 
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Other NMAC programs and services that might be of interest to your organization:  

 Government Relations and Public Policy Division

 Advocacy – NMAC in Action; Capitol Hill (policy-making)

 Women of Color Advocacy Institute

 Puerto Rico Advocacy 

 Upcoming Policy Reports 
 Native American and HIV/AIDS

 Black Gay Men and HIV/AIDS

 Latina/os and HIV/AIDS

 Transgenders and HIV/AIDS

Presenter
Presentation Notes
Instructor Notes:

ICBA – this is for directly and indirectly CDC-funded organizations. (Sometimes your health department has to request these services for you.) 


For more information about all of our services, please visit us at booth #48 – where you also can have your picture taken with NMAC staff and/or your friends and pick them up the next day – no charge! 
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Thank you for your joining us in Fort Lauderdale, FL. 

Please be sure to complete the online 2008 EAI Computer Grant 
Evaluation before you leave the session today. 

If you have any questions for NMAC staff, contact us at:

* communications@nmac.org or (202) 352-7240: 

During the conference, you can find us at: 

* NMAC Exhibit Booth #204
* USCA Press Room, Level 2, Room 216

Presenter
Presentation Notes
Instructor Notes:

ICBA – this is for directly and indirectly CDC-funded organizations. (Sometimes your health department has to request these services for you.) 


For more information about all of our services, please visit us at booth #48 – where you also can have your picture taken with NMAC staff and/or your friends and pick them up the next day – no charge! 

http://www.surveymonkey.com/s.aspx?sm=lCNR79ro3m9bnuCWVekxCQ_3d_3d�
http://www.surveymonkey.com/s.aspx?sm=lCNR79ro3m9bnuCWVekxCQ_3d_3d�
mailto:communications@nmac.org�
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Equal Access Initiative:
HIV/AIDS Information Resources from 
the National Library of Medicine

Instructors:

Nicole Dancy, National Library of Medicine

Wilma Templin-Branner, Oak Ridge Institute 
for Science and Education

For recipients of

National Minority AIDS Council
2008 Equal Access Initiative Computer Grants

United States Conference on AIDS
September 19-21, 2008
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Purpose

 To familiarize participants with reliable online health 
information from the National Library of Medicine and 
other reputable resources that address HIV/AIDS and 
related medical conditions

 To enable representatives of community organizations to 
effectively access treatment and prevention information to 
better serve their clients, colleagues, and communities

Presenter
Presentation Notes
 Workbook:  Introduction, page __
Add text
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Objectives

After completing this class, participants will be able to

 Identify and evaluate quality, accurate, and authoritative 
online resources pertaining to HIV/AIDS information and 
related medical conditions

 Demonstrate the ability to perform strategic search 
techniques in order to find HIV/AIDS treatment and 
prevention information

 Apply the skills and knowledge obtained in this course to 
their organization’s culture

Presenter
Presentation Notes
 Workbook:  Introduction, page __
Add text
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The National Library of Medicine

The world’s largest biomedical library

Part of the National Institutes of Health
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Why the National Library of 
Medicine?

 Easy

 Quick access

 Quality information

 Free



13http://www.nlm.nih.gov
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14

For the Public

Presenter
Presentation Notes
 Workbook:  Introduction, page __
Add text
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For Health Care Professionals



16http://aids.nlm.nih.gov
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NLM Resources

 AIDSinfo

 ClinicalTrials.gov

 MEDLINE/PubMed 

 MedlinePlus

 NLM Gateway

 DIRLINE

Additional Resources:

 National Minority AIDS Council

 Office of AIDS Research

 Centers for Disease Control and 
Prevention

NLM resources covered in this class will be:
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NLM Database Assistance

 Training Manuals
– PubMed, NLM Gateway, ClinicalTrials.gov
– http://www.nlm.nih.gov/pubs/web_based.html

 PubMed Help/FAQ and Tutorial   
– http://pubmed.gov (see links on sidebar) 

 NLM Fact Sheets
– http://www.nlm.nih.gov/pubs/factsheets/factsheets.html

Presenter
Presentation Notes
 On the inside back cover of your manual you will find the urls for additional training materials and contact information for NLM . 

http://www.nlm.nih.gov/pubs/web_based.html�
http://pubmed.gov/�
http://www.nlm.nih.gov/pubs/factsheets/factsheets.html�
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The National Network of Libraries 
of Medicine (NN/LM)

 Call to find your NN/LM Regional Medical Library
– 1.800.338.7657
– Monday-Friday 8:30 a.m. – 5:00 p.m. in all time zones

 Visit the NN/LM Web site
– http://nnlm.gov
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The World at Your Fingertips

Basic Internet Skills
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What is the Internet? The World 
Wide Web?

 The Internet and the World Wide Web (Web) are not the 
same thing

– The Internet is a worldwide network of computer networks 
that can all “talk” to each other using languages called 
“protocols”

– The Web is only one portion of the Internet – the best 
known part

 The Web is viewed with a graphical interface software 
called a “browser,” such as 

– Microsoft’s Internet Explorer
– Mozilla Firefox

Presenter
Presentation Notes
And why do I want to use the Internet? So I can get free and reliable health information from the National Library of Medicine and other sources whenever I want to, such as:
 I am in my pajamas and I don’t feel like leaving the house.
 My doctor’s office is closed.
 I or someone in my family is starting to have symptoms of something and I’d like to research it before we go to the doctor.
 I want to be able to discuss treatment options with my doctor.
 I want to be anonymous while I am researching a health question.




22http://www.nlm.nih.gov – a World Wide Web Site

Presenter
Presentation Notes
This is the National Library of Medicine’s home page.

Type the URL (Uniform Resource Locator) into the address field
- The URL is the “Web address”
   - You don’t have to type http:// 
- Just type: “www.nlm.nih.gov”

Not all addresses begin with “www”
An example is http://medlineplus.gov
Always use the correct UPPER and/or lower case letters in a URL
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Uniform Resource Locator

 A URL is made up of
– The “protocol” name (language) http://
– The “server” name nlm.nih.
– The “domain” name gov
– And sometimes also

• A directory name and/or portals
• A file name public.html

http://www.nlm.nih.gov/hinfo.html
http://www.nlm.nih.gov/portals/public.html

Presenter
Presentation Notes
Domain Names
.gov = government
.com = commercial
.org = non-profit organization
.edu = educational
.net = network host
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Using the Navigation Toolbar

 Go Back to the previous page or Forward to where you 
just were

 Click Stop to stop loading a page

 Click Refresh to reload a page

 Go Home to your starting page 

Presenter
Presentation Notes
Highlight the Icons on the toolbar and their function.
Click Search to find information on the Internet.
Click Favorites to go to pages you have “bookmarked.”
- Saves links to pages you visit often!
Click History to view pages you have visited recently.
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Using the Navigation Toolbar

 Click Print to print the page you are on, 
but be careful!

– One Web page can be many pages when printed
– Use Print Preview (under the File pull-down menu) to see 

how many pages will be printed
– If the Web page you are viewing has frames, be sure to 

click your cursor in the frame that you want to print

 Click Mail to send the page to someone

Presenter
Presentation Notes
Find in Page (Ctrl F)
Select Find (on This Page) from the Edit pull-down menu
For finding key words on a long page of text
Increase or decrease Text Size
Select Text Size from the View pull-down menu
For increasing or decreasing the size of the text on the page
Change Internet Options
Select Internet Options from the Tools pull-down menu
For customizing your browser
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Bookmarking Favorite Pages

 Go to the page you want to bookmark

 Click Favorites and select Add to Favorites…

 Organize your bookmarks for easier use
– Click Favorites and select Organize Favorites…
– Click Create Folder

• Type a name for the new folder
– Drag and drop saved bookmarks to any folder

 To delete a bookmark you don’t want any more
– Click Favorites, right-click the bookmark you want to delete, and 

select Delete

Presenter
Presentation Notes
Just go ahead and make a note to bookmark http://www.aidsinfo.nih.gov/ and  http://medlineplus.gov when you get home.  You’ll use both a lot!
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Changing Your Home Page

 Click the Tools menu and select
Internet Options

 In the Internet Options dialog box, type the URL of your 
chosen page (e.g. http://www.nlm.nih.gov), 

 Or… Go to the page you want to use as your home page, 
click Tools/Internet Options, 
then click the Use Current 
button below the address
box
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 Look for links of topics of interest to click. Links can be
– A word, a phrase, or a sentence
– A picture or graphic image
– You’ll know it’s a link when the mouse arrow 

pointer turns into a pointing finger 

 Look for Frequently Asked Questions (FAQs)

 Look for an electronic forum

Exploring a Web Site

Presenter
Presentation Notes
Sometimes a link is underlined.
Don’t always trust everything you read in an electronic forum.  If the other participants are not qualified, impartial medical personnel, you may be reading misinformation.  Double-check anything you read in an electronic forum with another reputable medical resource.
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Search Directories 

 Organized by subject

 Categorized and indexed (“hand-picked”) by people

 For broad, general topic searches 

 Examples
– Google Directory at http://www.google.com/dirhp
– Yahoo Directory at http://www.yahoo.com > Directory
– Open Directory Project at http://dmoz.org
– LookSmart Directory at http://looksmart.com/x02

Presenter
Presentation Notes
You might want to use a directory if you would like to browse for information rather than immediately typing something into a search engine search box.
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Search Engines

 Index documents and match text to key words requested 
by the user

 Two types
– Searches a large portion of pages on the Web
– Searches within topics, regions, or sites

 Some search engines are also Web portals, including 
Google, Yahoo!, and Ask.

http://www.google.com http://www.yahoo.com http://www.ask.com

Presenter
Presentation Notes
At this time, Google is the most popular search engine and indexes the largest number of Web pages, so it might be a good place to start.  Ask.com contains brief articles on topics and might be good if you are looking for that type of information.
Recommended Search Engines: Tables of Features
http://www.lib.berkeley.edu/TeachingLib/Guides/Internet/SearchEngines.html
Search Engine Features Chart from Search Engine Showdown
http://searchengineshowdown.com/features/
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Your Search Strategy

 PLAN!
– What are you looking for? 
– Is the Web the best place to find the information?

 ACT!
– Know which search tool(s) to use

 REVIEW!
– Did the information you find answer your question?
– Do you need to redefine, narrow, or expand your topic?

Presenter
Presentation Notes
You can always call and ask to talk to a reference librarian at a public library (although you might not talk to a specialist in health information at the public library) or a medical library, too.  Sometimes the information you are looking for is not on the Internet, or you might not know the right words to use to search for it.
Many public and medical libraries take reference questions by e-mail, too.
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How to Construct a Search

 Formulate the search question 
– What information is available about treatment options for 

children with HIV?

 Identify the important concepts within the question
– Children, HIV, treatment

 Identify the search terms to describe those concepts
– Children, HIV, treatment

Presenter
Presentation Notes
It helps to write down the words that are the most important in your search question.
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How to Construct a Search

 Consider synonyms and variations of those terms
– Children, childhood 
– Childhood, juvenile, youth, child, adolescent

 Prepare your search logic (Boolean logic)
– (children OR childhood) AND hiv AND treatment 

Presenter
Presentation Notes
“Pediatric” might be a good search term to use in this search, too.  If you are looking for information on the youngest children, try “infants.”
Go ahead and do a search, and read through the results to see what other words are appearing in the results to see if you need to refine your search terms.
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Boolean Logic

 Boolean commands:  AND OR NOT
– HIV AND AIDS (finds all search terms)
– Treatment OR Therapy (finds either term or both)
– Tuberculosis NOT Pneumonia (eliminates specified terms)

 Nested parentheses
– Common cold AND (vitamin c OR zinc)

Presenter
Presentation Notes
If you search HIV AND AIDS, you will get results that contain both words.  This will narrow down your search results.
If you search Treatment OR Therapy, your results will have one or the other word.  This will broaden your search.
If you search Tuberculosis NOT Pneumonia, your results will include items with the word Tuberculosis but you will not find any items with the word Pneumonia.
Nested parentheses are a way to combine the AND and OR Boolean commands.
If you search Common Cold AND (Vitamin C OR Zinc), your results will include all items that contain Common Cold AND Vitamin C, as well as items that contain Common Cold AND Zinc.
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Narrow a Search

 To narrow a search on apples, you could
– Add more words

• apples macintosh
– Search as a phrase

• “apple pie recipe”
– Exclude words

• apples – macintosh
• apples NOT macintosh

Presenter
Presentation Notes
-The absence of any Boolean commands usually defaults to the “AND” Boolean command.  (i.e., if you just put spaces between the words, your search results will include ALL of the search terms.)
-Quotation marks to search phrases usually limit your search results to items that contain all of the search terms, in the order in which they appear in the quotation marks.
-The minus sign acts as the Boolean command “NOT” in many search engines.
Other examples:
Apple macintosh computer (to find the computer and not the fruit)
“heart attack” if you want the words related together as a phrase and not just the appearance of the words heart and attack in the results
Bass –fish (if you are looking for guitars)
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Broaden a Search

 To broaden a search on “macintosh apples” – Fiji
– Use a broader term

• apples
– Use fewer words
– Do not search as a phrase
– Do not exclude words

Presenter
Presentation Notes
AND narrows a search
NOT narrows a search
OR broadens a search
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Printing Web Pages

 Different types of files on the Internet

 Most common file types
– HTML files – indicated by extension “.html” or “.htm”
– Adobe Acrobat files – indicated by extension “.pdf”

 On your Web navigation tool bar, click the print icon – or 
click the File pull-down menu and select Print
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Printing HTML Pages

 HTML pages may not print as seen on screen

 Use Print Preview (on the File pull-down menu) to see 
how the page will print and how many pages will be 
printed

 If the Web page you are viewing has frames, be sure to 
click your cursor in the frame that you want to print

Presenter
Presentation Notes
Reminder—you may not want to print several pages, so check how large the Web page is before you print it by using Print Preview or by seeing how far the page scrolls down.
Make sure you are in the right frame.  There is nothing more frustrating than printing a page and realizing that you printed the wrong thing.  There are some pages on the Web you might not be able to print anyway, but those are rare.
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Saving Web Pages

 On the navigation tool bar, click the File pull-down menu 
and select Save As

 A window will pop up to 
allow you to select the 
folder in which you want 
to save the document

 Select a folder and click
the Save button
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About Adobe PDF Pages

 Adobe PDF (PDF) is a universal file format
– Standard for worldwide electronic document distribution
– Created by Adobe Systems, Inc.

 PDF files will print as they appear on screen

 PDF displays document information intact
– Page numbering
– Illustrations

 Free program to read PDF files is called Adobe Reader
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Adobe Reader 

http://www.adobe.com/products/acrobat/readreadstep2.html

Presenter
Presentation Notes
Go to http://www.adobe.com
Or click the Get Adobe Reader icon:
Click System requirements under Download Information to review requirements before downloading and installing Adobe Reader
Click the Download button, then select “Open” from the menu choices – the file will automatically download to your computer
Click Install Now




42http://www.oar.nih.gov/strategicplan/fy2009/pdf/Preface.pdf

Presenter
Presentation Notes
Point out the following features:
On the Adobe Reader top left tool bar, click the Save button.
There are multiple tool bars with many other features in Adobe Readers that allow you to: 
Find a word/phrase within the document
Navigate the document
Zoom
Select text/column/graphics for copying
. . . and much more
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Printing Adobe PDF Pages

Presenter
Presentation Notes
Use the Print button on the Adobe Reader tool bar (not your Web browser tool bar) to print the document.
The small window at the bottom of the screen will tell you how many pages are in the file.
If you click a link for a PDF file, Adobe Reader will automatically open the document.



44http://www.oar.nih.gov/strategicplan/fy2009/pdf/Preface.pdf

Presenter
Presentation Notes
You can also save PDF files.
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Caution

 Computer viruses are transmitted through e-mail and can 
be harmful to your computer!

– Do not open a suspicious e-mail message
– Immediately delete it and then empty your Deleted Items 

folder

Presenter
Presentation Notes
An e-mail might be suspicious if it is from someone you don’t know and the subject line does not sound like anything you would be interested in.  A virus is usually (but not necessarily) contained in an attachment.  Do not open any attachments from strangers, and do not open attachments that just sound wrong even if it is from a friend—some viruses can automatically send themselves out from other people’s computers. 
If you get an e-mail from Nigeria or from someone you don’t know asking for money so that they can deposit more money in your bank account, do not send them any money.  This is a well-known scam.
Your bank, mortgage company, eBay, Amazon, or PayPal will NEVER e-mail you and ask for your account information--this is another common scam.  They have your account information.  Never respond to someone over e-mail with your bank account, birth date, Social Security number, or credit card information.
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Finding Quality Health Information
on the Internet

Where to Start and 
How to Evaluate the Information you Find
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Why the Internet?

 Abundance of FREE information
– Medical journals/databases
– Clinical trials
– Treatment information
– Prescription drugs

 24-hour-per-day availability

 Current awareness

 Connecting with others with similar medical 
problems

 Anonymity/privacy

Presenter
Presentation Notes
The growing popularity of the Internet has made it easier and faster to find health information. Much of this information is valuable; however, the Internet also allows rapid and widespread distribution of false and misleading information. It is important for people to carefully consider the source of information and to discuss the information they find with their health care provider. The fact sheet in the back of your manual can help you decide whether the health information that you find on the Internet or receive via e-mail from a Web site is likely to be reliable.
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Evaluating Internet Resources

 Be careful: Information on the Internet may be unreliable

 Be savvy: Evaluate the information you find

Presenter
Presentation Notes
Content on the Internet is unregulated, and therefore, anyone can publish anything on the Internet.  There is evidenced -based medical information on the Internet along with false and misleading information.  You need to be able to tell the difference!
Ask yourself the following:
Why did the person create the page?  
What’s in it for them?  
Are they trying to sell me something?
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Savvy Health Surfing

 Authority

 Accuracy

 Coverage

 Currency

 Objectivity

 Design Features



51

Cases of Inaccurate Web 
Information

 Johns Hopkins University’s and C. Everett Koop’s 
Web sites were slow to add information on new hepatitis 
treatments

 Reports of anthrax exposure have resulted in fraudulent 
Web sites selling products to protect 
against biological threats
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Cases of Inaccurate Web 
Information

 Home HIV tests
– Many home HIV test kits sold over the Internet 

supply inaccurate results according to the 
Federal Trade Commission

– Correct information: Only one home test is 
reliable, as per the Food and Drug 
Administration (FDA)

• Home Access Express HIV-I Test System
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Caution

 Avoid Web sites that:

 Advertise a "new cure" for a serious disorder or 
a quick cure-all for a wide range of ailments

 Use impressive-sounding terminology to 
disguise a lack of good science or those that 
claim the government, the medical profession, 
or research scientists have conspired to 
suppress a product

 Include undocumented case histories claiming "amazing" 
results

Presenter
Presentation Notes
FDA offers these tips to consumers who buy health products online: 

- Check with the National Association of Boards of Pharmacy to determine if the site is a licensed pharmacy in good standing (visit the Website at www.nabp.net, or call 847-698-6227). 

- Don't buy from sites that offer to prescribe a prescription drug for the first time without a physical exam, sell a prescription drug without a prescription, or sell drugs not approved by FDA. 

- Don't do business with sites that do not provide access to a registered pharmacist to answer questions. 

- Avoid sites that do not identify with whom you are dealing and do not provide a U.S. address and phone number to contact if there's a problem. 

- Beware of sites that advertise a "new cure" for a serious disorder or a quick cure-all for a wide range of ailments. 

- Be careful of sites that use impressive-sounding terminology to disguise a lack of good science or those that claim the government, the medical profession, or research scientists have conspired to suppress a product. 

- Steer clear of sites that include undocumented case histories claiming "amazing" results. 

- Talk to your health-care professional before using any medication for the first time. 
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Evaluating Internet Resources

 Use your best judgment and these criteria to 
evaluate information on the Internet

 Consult your health care professional before 
making any treatment decisions



55http://www.nlm.nih.gov

http://www.nlm.nih.gov/�


56http://aidsinfo.nih.gov

http://aidsinfo.nih.gov/�


57http://clinicaltrials.gov

http://clinicaltrials.gov/�


58http://www.pubmed.gov

http://www.pubmed.gov/�


59http://medlineplus.gov

http://medlineplus.gov/�


60http://gateway.nlm.nih.gov

http://gateway.nlm.nih.gov/gw/Cmd�


61http://dirline.nlm.nih.gov

http://dirline.nlm.nih.gov/�
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